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第Ⅰ章
研究の目的

　本研究は、2015 年に奈良町遺跡（奈良市柳町）で出土した江戸時代初頭の刀装具鋳造鋳型に対して
SfM を用いた三次元計測を実施し、これにより得た基礎情報から近世鋳造技術の一端を解明すること
を目的とする。
　研究代表者は、奈良市教育委員会文化財課埋蔵文化財調査センターに所属し、2015 年に奈良町遺跡
の発掘調査を担当した。その際、江戸時代初頭の鋳造炉および鋳造関連遺物を廃棄した土坑を検出した。
鋳造関連遺物には坩堝、鋳型、炉壁等があり、これらは近世鋳造技術を解明するのに非常に良好な資料
である。しかし、このような遺構・遺物の類例は非常に乏しく先行研究も少ないため、基礎研究を積み
重ねる必要があった。
　このような状況から、研究代表者は近世鋳造技術の解明を目的とした概ね５年計画の研究を 2018 年
度より実施している。その詳細は以下の通りである。
研究題目：近世鋳造技術の研究
研究計画：１年目　近世刀装具鋳造鋳型の製作技法に関する分析
　　　　　２年目　近世刀装具の製作技法に関する分析
　　　　　３年目　坩堝からみた近世鋳造技術の分析
　　　　　４年目　近世鋳造工程の復元的研究
　　　　　５年目　近世鋳造技術の総合的研究
　上記の計画的な研究課題をもとに、近世鋳造技術について解明することを最終的な目標としている。
本研究は、この初年度にあたる研究課題について取り組むものである。
　初年度の研究課題である本研究は、近世刀装具鋳造鋳型の製作技法を解明することを主な目的とする。
この基礎資料は奈良町遺跡出土品とするが、点数は多いものの、製品を取り出す際に砕かれており、多
くが細片となっている。さらに、被熱により黒色化し観察が困難である。この状況から一般的な実測方
法である手測りによる図化は難しく、さらに垂直写真でも図像が不明瞭で図示するのが困難であった（奈
良市教育委員会 2018）。
　そこで、有効な方法として SfM による三次元計測がある。レーザによる三次元計測はすでに考古学
分野において銅鏡などに用いられている（水野 2010）が、非常に高価であり一般への普及は非現実的
である。対して SfM はデジタルカメラ、パソコン、解析ソフトがあれば比較的安価での計測が可能で
あり、近年考古学分野で有効性が示されつつある（文化財方法論研究会 2016）。
　そこで本研究では、SfM を用いた三次元計測を行うことで、鋳型の基礎データを抽出することを第
一段階の目標とした。次に、得られた基礎データをもとにして、鋳型の製作技法を明らかにすることを
第二段階の目標とした。鋳型の製作技法を明らかにすることは、近世鋳造技術の実態を示すための重要
な課題である。初年度はこの課題を解決することを目指す。
　また、研究代表者は行政職員でもあり、費用対効果を意識した仕事がとくに求められる立場にある。
SfM による三次元計測は、従来の方法とうまく併用すれば非常に高い効果が期待できると考えている。
この点についても、本研究を通して得た知見をもとに見解を示す。
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図１　HJ 第 688 次　刀装具鋳型
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第Ⅱ章
奈良町遺跡出土近世刀装具鋳型・製品の報告

第ⅰ節　奈良町遺跡における近世刀装具鋳造関連遺構・遺物について
概要　本研究で対象するのは、奈良市教育委員会が2015年度に実施した平城京跡（HJ）第688次調査（平
城京跡・奈良町遺跡）で出土した資料である。
遺跡名：平城京跡（左京四条六坊六坪）・奈良町遺跡　　調査原因：共同住宅新築
調査地：奈良市柳町 10-1、南魚屋町 1-3 他　　調査期間：平成 27（2015）年５月７日〜６月 26 日
調査面積：383㎡　　調査担当：村瀨　陸（奈良市教育委員会）
遺構　本調査では、平安時代には埋まったと考えられる河川が発掘区の大部分を占めており、平城京跡
に関する遺構はなかった。主に検出した遺構は、江戸時代初頭の鋳造炉、鋳造遺物を廃棄した土坑であ
り、その詳細を記述する。
土坑ＳＫ 01～ 13　いずれも鋳造関連の遺物や、埋土に焼土および炭混じりの黒色土を含む。深さは
0.3 〜 0.5m でオーバーハングするように掘り込まれる。これらの土坑はいずれも粘土質の地山である
部分にしかみられないことから、粘土採掘の為に掘削された後、廃棄土坑として利用したと考えられる。
　ＳＫ 02 ～ 06 では、土坑ごとに出土遺物の特徴が確認できた。ＳＫ 02 からは坩堝・炉壁等の破片を
中心とする遺物、ＳＫ 03 からは鐔の鋳型、ＳＫ 04 からは目貫の鋳型と三足付坩堝、ＳＫ 06 からは多
数の把手付坩堝の完形品がそれぞれ主体をなしている。

鋳型 坩堝 炉壁 土器

点数 比率 点数 比率 重量
（ｇ） 比率 点数 比率

SK06 260 1.07 2690 70.38 20774 26.58 1745 50.77
SK02 3488 14.41 385 10.07 14463 18.51 241 7.01
SK03 7199 29.75 30 0.78 5979 7.65 99 2.88
SK04 10884 44.97 271 7.09 17341 22.19 359 10.45
SK05 2352 9.72 92 2.41 9484 12.14 257 7.48
SX14 7 0.03 114 2.98 5161 6.60 157 4.57
SK12 4 0.02 124 3.24 956 1.22 0.00
SK10 1 0.00 13 0.34 803 1.03 228 6.63
SK08 4 0.02 79 2.07 1524 1.95 261 7.59
SK09 3 0.01 24 0.63 1661 2.13 90 2.62
合計 24202 100.00 3822 100.00 78146 100.00 3437 100.00
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表１　HJ 第 688 次調査　遺構別主要遺物出土点数表ＳＸ 14（炉）　約３×1.5m の掘方の内側に、
円形に炭層が残る部分が２ヶ所あり、その周囲
にはしまりのある橙色土がめぐる。この下層に
は、焼土や灰白色土に炭がラミナ状に入る層が
ある。また、南側に鋳造遺物を含む廃棄土坑が
あることから、この遺構は炉の床面が残存する
ものと考えられ、以下では炉として記述する。
炉は重複関係から同一場所で数回の構築と破壊
を繰り返している。断面観察により、炉は最終
作業面に相当する炉１～３と、これらの下層整
地層に旧作業面が想定できる。
　最終作業面で確認した炉１は、径約 0.3m の
炭層の周りに径約 0.5 ｍの灰白色土がめぐり、
さらにその外側をやや焼けしまった橙色土が囲
う。炉２は、径約 0.5 ｍの炭層を炉１同様の橙
色土が囲う。炉１・２ともに、炉の床面を示す
と考える円形の炭層は、厚さ約 0.05 ｍしか残
存しない。炉１は灰白色土がめぐる一方、炉２
にはそれが確認できず、なんらかの機能差が考
えられる。重複関係から炉３は炉１・２より古
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図２　HJ 第 688 次　発掘区平面図（1/200）

図３　HJ 第 688 次　SX14（炉）平面・断面図（1/50）
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図４　HJ 第 688 次　SK02 〜 SK06（南西から）

図６　HJ 第 688 次　SK03（東から）図５　HJ 第 688 次　SK02（西から）

図７　HJ 第 688 次　SK06（北東から） 図８　HJ 第 688 次　SX14（南から）
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い。周囲の地山は焼けて赤色を呈する。
　炉周辺には建物に復元できるような柱穴がなく露天である可能性が高い。建物は柱穴の集中度からみ
て炉の北東方向に広がる可能性がある。
遺物　鋳造に関連する遺物には、鋳型、目貫製品、坩堝、炉壁類、金属鋳造に関する生成物、砥石、円
盤状土製品等がある。鋳型については次節で述べる。
　坩堝は約 3800 点出土しており、中島和彦により以下の分類がなされ８型式を確認した。
Ⅰ類：口径に対して器高が低く、鉢形となるもの。
Ⅱ類：口径に対して器高が高く、コップ形となるもの。

１

２ ３

４

５

６

７

８

９ 10 11
12

０ 20㎝

図９　HJ 第 688 次　坩堝類（１/ ４）

遺構
坩堝　
鉢形

（Ⅰ類）

坩堝　コップ形（Ⅱ類）
坩堝　
蓋

形態
不明

合計
把手付
（１）

三足付             
（２）

把手三足
付（３） 体部 小計 （破片

点数） 比率

SK02 27 44 23 39 153 259 99 0 385 11.10
SK03 12 1 2 1 9 13 5 0 30 0.87
SK04 27 0 36 0 148 184 59 1 271 7.81
SK05 41 0 9 0 30 39 12 0 92 2.65
SK06 35 320 1 0 2325 2646 9 0 2690 77.57
小計 142 365 71 40 2665 3141 184 1 3468

比率 4.09 10.52 2.05 1.15 76.85 90.57 5.31 0.03

－１　体部外面の側面に、縦方向の長方形
の把手を１つ付すもの。
－２　底部外面に三足を付すもの。
－３　１の把手と２の三足いずれも付すも
の。
ａ：蓋を伴うもの　ｂ：蓋を伴わないもの
　これらの坩堝は、蛍光 X 線分析が実施
されており、概要報告ではⅠ類坩堝から青

表２　HJ 第 688 次調査　遺構別坩堝出土点数表
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銅、Ⅱ類坩堝から銅および亜鉛（真鍮）が検出された
ことが記されている（１）。
　炉壁類には、様々な形状の炉壁のほか鞴羽口なども
出土している。近世における炉の構造は多様であり、
とくに本調査で出土したⅡ類坩堝と組み合う炉がどの
ようなものであったかは重要な検討課題である。出土
した炉壁のなかには、香取秀眞の「御鏡仕様之控書註
記」に記された馬のりに該当するであろう形状のもの
があり、ほかにも弧を描く板状の炉壁を組み合わせて
使用したと考えられるものがあることから、屏風（丸
瓦状の炉壁を組み合わせた構造物）をもとにした簡易
的な炉が想定できる。
　金属鋳造に関する生成物は、鋳造工程の中で生じた

図 11　HJ 第 688 次　炉壁類（１/ ４）

図 10　「御鏡仕様之控書註記」記載の「土道具」類

１

２

３

４

５

０ 20㎝



第Ⅱ章　奈良町遺跡出土近世刀装具鋳型・製品の報告

8

種
類 産地等 器種

SK02 SK03 SK04 SK05 SK06 SK08 SX14 鋳造関連遺構　
合計

点数 出土
比率 点数 出土

比率 点数 出土
比率 点数 出土

比率 点数 出土
比率 点数 出土

比率 点数 出土
比率 点数 出土　　

比率

土
師
器

褐色系 (A) 群 皿 16 6.64 1 1.01 33 9.19 14 5.45 52 2.98 14 5.36 18 11.46 148
灰色系 (C) 群 皿 101 41.91 83 83.84 131 36.49 123 47.86 441 25.27 54 20.69 27 17.20 960
灰色系 (D) 群 皿 1 0.38 15 9.55 16

羽釜 51 21.16 4 4.04 67 18.66 84 32.68 176 10.09 70 26.82 30 19.11 482
小計 168 69.71 88 88.89 231 64.35 221 85.99 669 38.34 139 53.26 90 57.32 1606 51.49

瓦
質
土
器

擂鉢 4 1.66 2 2.02 6 1.67 8 3.11 134 7.68 11 4.21 11 7.01 176
捏鉢 1 0.41 15 0.86 1 0.38 1 0.64 18
浅鉢 1 0.06 1
方形浅鉢 0
深鉢 7 2.90 2 0.56 2 0.78 26 1.49 7 4.46 44
鉢類 13 5.39 5 5.05 17 4.74 5 1.95 288 16.50 43 16.48 22 14.01 393
壺 4 1.66 4 0.23 1 0.38 1 0.64 10
風炉・焜炉 2 0.11 2
蓋 2 0.11 1 0.38 3
行燈 1 0.06 1 0.38 2
羽釜 1 0.39 1
不明 13 5.39 3 3.03 18 5.01 3 1.17 55 3.15 1 0.38 93

小計 42 17.43 10 10.10 43 11.98 19 7.39 528 30.26 59 22.61 42 26.75 743 23.82

国
産
陶
器

肥前

椀 8 3.32 12 3.34 8 3.11 281 16.10 45 17.24 10 6.37 364
皿 2 0.83 43 2.46 1 0.64 46
壺 26 1.49 26
鉢 28 1.60 2 0.77 3 1.91 33
他 2 0.11 1 0.64 3

小計 10 4.15 0 0.00 12 3.34 8 3.11 380 21.78 47 18.01 15 9.55 472

瀬戸・美濃

椀 6 2.49 9 2.51 4 1.56 29 1.66 5 1.92 53
皿 10 4.15 19 5.29 2 0.78 43 2.46 1 0.38 75
他 4 0.23 4

小計 16 6.64 0 0.00 28 7.80 6 2.33 76 4.36 6 2.30 0 0.00 132
備前 壷・甕 2 0.78 31 1.78 33

信楽
擂鉢 4 1.66 8 2.23 1 0.39 14 0.80 6 2.30 3 1.91 36
壷・甕 0.00 0

小計 4 1.66 0 0.00 8 2.23 1 0.39 14 0.80 6 2.30 3 1.91 36
小計 30 12.45 0 0.00 48 13.37 17 6.61 501 28.71 59 22.61 18 11.46 673 21.58

国
産
磁
器

肥前

碗 4 1.11 4
皿 2 0.56 2
他 4 1.11 4

小計 0 0.00 0 0.00 10 2.79 0 0.00 0 0.00 0 0.00 0 0.00 10 0.32

輸
入
陶
磁
器

青磁
碗 4 0.23 1 0.38 5
皿 0

小計 0 0.00 0 0.00% 0 0.00 0 0.00 4 0.23 1 0.38 0 0.00 5

白磁
皿 1 1.01 15 4.18 18 1.03 2 0.77 36
他 1 1

小計 0 0.00 1 1.01 15 4.18 0 0.00 18 1.03 2 0.77 1 0.64 37

青花

碗 1 0.41 7 1.95 6 0.34 1 0.38 2 1.27 17
皿 4 1.11 13 0.74 4 2.55 21
他 4 0.23 4

小計 1 0.41 0 0.00% 11 3.06 0 0.00 23 1.32 1 0.38 6 3.82 42
赤絵 碗・皿 1 0.28 2 0.11 3

小計 1 0.41 1 1.01 27 7.52 0 0.00 47 2.69 4 1.53 7 4.46 87 2.79
合計 241 100.00 99 100.00 359 100.00 257 100.00 1745 100.00 261 100.00 157 100.00 3119 100.00

表３　HJ 第 688 次調査　遺構別出土土器点数表
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図 12　HJ 第 688 次　SK06 出土土器（１/ ４）
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バリや湯玉等がある。これについても今後、詳細を明らかにすべき資料である。
　砥石は製品等の加工に用いたと考えられ、円盤状土製品は用途不明であるが鋳造関連遺物と同じ遺構
から出土したため、鋳造工程のなかで使用した可能性が高い。
土器類　約 3,000 点の土器が出土し、各遺構ごとの出土点数を一覧表に記した。出土比率は土師器が
約半数を占め、瓦質土器が約 1/4、残りが国産・輸入陶磁器類が占めている。国産陶器は肥前産が約７
割と主体を占め、瀬戸・美濃産がこれに次ぐ。瀬戸・美濃産陶器は灰釉・志野秞のものが多く、鉄秞の
天目椀の出土が少ない点が特徴である。また僅かながらも肥前産磁器の出土は注目できる。国産陶器の

図 13　HJ 第 688 次　SK02 〜 05・08・SX14 出土土器（１/ ４）
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擂鉢は、ほぼ信楽産で占められる。
　各遺構出土の土器は型式的にはほぼ同じで、元興寺旧境内第４次調査（GG 第 04 次）ＳＸ 06 出土
資料と同型式の 17 世紀第２四半期頃のものと考えられる（奈良市教育委員会 2018）。
遺跡の評価　以上の遺構・遺物から評価できる主な概要は以下３点である。
①近世刀装具に鋳造品のあることが考古学的に明らかとなったこと、②出土坩堝と共伴土器から 17 世
紀前半には真鍮の国内製造を行なっていたことが明らかとなったこと、③近世鋳造技術を考古学的に示
すことが可能な資料が得られたこと、である。
　この主な評価をもとに、今後はより緻密な分析を積み重ねることで、近世鋳造技術についてを明らか
にできるものと考える。

第ⅱ節　三次元計測を用いた出土鋳型・製品の報告

遺構
鐔

菊花小 菊花大 阿弥陀鑢 覆輪状 無文 他 小計
ＳＫ 02 43 0 79 5 165 134 506
ＳＫ 03 58 8 884 196 735 161 3263
ＳＫ 04 1 0 42 7 20 56 155
ＳＫ 05 3 0 38 2 7 13 80
ＳＫ 06 1 1 18 0 12 8 66

遺構
目貫

不明
雌外型 雌内型 雄外型 雄内型 他 小計

ＳＫ 02 653 113 20 368 155 1309 1673
ＳＫ 03 94 107 15 127 177 520 3416
ＳＫ 04 1264 549 275 1268 179 3535 7194
ＳＫ 05 340 133 83 269 14 839 1433
ＳＫ 06 0 18 2 4 32 56 138

概要と出土状況　奈良町遺跡で出土した鋳型（破
片点数約 24200 点）には、刀装具である鐔・目
貫を主とし、不明鋳型が若干数ある。主体である
鐔・目貫の鋳型には雌雄型があり、製品見本や鍛
造用の文様型ではなく、鋳造に用いた実用鋳型で
ある。
　鐔の鋳型は、肉眼観察で文様の違いを読み取る
ことが可能であるが、目貫は図像が把握できるも
のとできないものがある。そのため、表４では鐔
を種類ごとに、目貫は雌雄型で分類して出土遺構
単位で点数計算した。これをみると、鐔の鋳型は
SK03、目貫の鋳型は SK04 から特に多数出土し
ていることがわかる。SK02 〜 06 の出土土器に時期差は認められないが、土坑への廃棄が作業単位を
反映している可能性が高い。鐔・目貫の必要金属量は異なるため、意図的に鋳造作業を切り分けたと想
定できる。また、目貫鋳型のなかでも天女図は SK02 から出土する割合が高く、その他の種類とは異な
るタイミングで製作されたことを反映していると考えられる。
　なお、SK06 からは上述したように多量の土器類と坩堝が目立って出土した。一方で鋳型が極端に少
ないことからみて、使い回しのできる坩堝、及び日常的に使用する土器を廃棄した SK06 は最終的な廃
棄であろうと考えられる。
鋳型の分類　前述の通り、鋳型には主に鐔と目貫があり、若干の不明鋳型がある。
　鐔の鋳型は、外形が円形・木瓜形の２種類で、文様が菊花（菊花小）・複弁菊花（菊花大）・阿弥陀鑢
状・覆輪状・無文の５種類ある。ただし、木瓜形は阿弥陀鑢状の文様をもつものにしか確認できない。
全て中心孔と小柄櫃孔のみの鐔である。外形のわかる資料が乏しいため、基本的には文様を優先した分
類とし、略称（菊花＝ TK、複弁菊花＝ TKH、阿弥陀鑢状＝ TA、木瓜形阿弥陀鑢状＝ TAM、覆輪状
＝ TH、その他＝ TS）を使用する。
　目貫の鋳型は、外形が円形・方形の２種類あり、雄型（＝ MO）と雌型（＝ MM）がある。ひとつ
の鋳型に１〜２つの笵型があるものと３つあるものとがある。ただし、破片であるため外形や笵型数が

表４　鐔・目貫鋳型の内訳
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わかるものに乏しく、笵型の図像をもとに分類する。肉眼観察による図像の判別は龍・獅子・葉・花文
がある程度の認識に過ぎなかった（奈良市教育委員会 2018）が、三次元計測により具体的な様相を明
らかにすることができた。この結果をもとに分類すると、獅子、連獅子、龍 A・B、見返龍 A・B、天
女 A 〜 G、山椒、花、葉、独鈷、兎、不明動物があり、その他図像不明のものが若干数ある。とくに、
獅子図や龍図は、後藤家の意匠を採用したもので、その模倣品であることがわかる。模倣品である根拠
としては、後藤家の作品は鍛造品が多く、基本的に三所物（目貫・小柄・笄）しか製作せず鐔を製作す
ることは皆無に等しいことが挙げられる。本調査では目貫と鐔が鋳造により製作されていることからも、
後藤家と直接結びつくことはない生産体制によるものである。また概要報告書では、大多数が龍図であ
ると考えていたが、その一部が天女であることがわかった。さらに多種なだけでなく、同一意匠であっ
ても龍や天女図のように複数種存在することも明らかとなった。
　なお、報告した資料以外にも未使用品が廃棄された資料があり、X 線分析により内部が判明した資
料（図 14）があるほか、接合することで鋳型の構造がよくわかる資料（図 24）などもある。これらは
SfM による図化が困難であるため、この手法による掲載は断念した。
鋳型の構造　鋳型は鐔・目貫に関わらず同様の構造を呈する。つまり、笵型を施す面は精良な粘土を用

1 2 3 4

5 6 7 8

0 5cm

図 14　HJ 第 688 次　未使用鐔鋳型（左：菊花、右：無文）

図 15　HJ 第 688 次　目貫製品の X 線分析画像（１/ １）
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いているが、その外側はスサ混じりの粗い粘土で覆われており、２層構造となっている。雄型と雌型を
合わせて目張りする粘土も粗いものを用いている。これは鋳造時のガス抜きを意図したものであると考
えられる。
製品　８点の目貫があり、ほかにも製品の可能性がある金属片が若干数ある。目貫製品には、獅子、龍、
剣巻龍、布袋、独鈷、図像不明がある。獅子図は、鋳型で確認されているものと同一意匠であるが細部
に若干の違いがある。また龍図や独鈷図も鋳型では見つかっていない意匠であり、剣巻龍や布袋図は鋳
型で確認されていない。これらの製品は、金属原型や当遺跡での鋳造製品と想定したいところであるが、
上述の実態からその他の理由で持ち込まれたものである可能性があろう。
計測所見　以上、鐔・目貫の鋳型を SfM を用いて三次元計測し、図示及び一覧表で基礎データを提示
した。概要報告書作成段階における肉眼観察では、図像の把握が困難であったが、三次元計測によりそ
の詳細が格段に判明した。また、図像の正確かつ明瞭な図化方法としても有効であり、細部の比較検討
にも耐えうる。
　一方、三次元レーザで計測したデータと比べると、点群数やその正確さに欠けており、仕上がりモ
デルでも SfM はレーザに比べて無理やり点群を繋いでモデル化した部分が細部で確認できる。よって、
厳密に数値化して笵型の細部比較をする場合には SfM 計測データでは問題がある。
　また、今回提示した目貫製品は、例えば獅子図目貫では処理後においても一定の錆が覆っており、本
来の細部形状が不明瞭である。このため、SfM では現状の状態を計測することしかできないが、X 線撮
影画像では、本来の形状を一層読み取ることが可能である。よって、X 線 CT 等による三次元計測がで
きればより有効なデータが得られると予測する。
　このように、SfM を用いた三次元計測には有効性と問題点が存在する。しかし、今回対象とした鋳
型は SfM を用いた計測が非常に有効であることを示した。当然、レーザによる三次元計測ができるに
越したことはないが、費用対効果や埋蔵文化財行政における持続可能な方法としてみれば、SfM は本
資料に対して有効であったと言える。
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TA１ TA２ TA３ TA４ TA５ TA６

TA７ TA８ TA９ TA10 TA11 TA12 TA13 TA14

TA15 TA16 TA17 TA18 TAM１ TAM２ TAM３

TAM８ TAM９ TAM10TAM７TAM６TAM５TAM４

TH１ TH２ TH３ TH４ TH５ TH６ TH７ TH８

TK１ TKH２TKH１ TS１ TS２ TS３ TS４ TS５
0 10cmS=1/2

図 16　HJ 第 688 次　出土鋳型の三次元モデル（鐔）
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MM７

【龍 A】

MM15 MM17 MM37

MM45 MM46 MM48

【龍 B】

MM51

【龍 B?】

MM６ MM16 MM47

【見返龍 A】

MM８ MM31 MM39 MM42 MM43

【見返龍 B】

MM５ MM13

MM18

MM32

0 5cmS=1/1

図 17　HJ 第 688 次　出土鋳型の三次元モデル（目貫）
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図 18　HJ 第 688 次　出土鋳型の三次元モデル（目貫）
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図 19　HJ 第 688 次　出土鋳型の三次元モデル（目貫）
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0 5cmS=1/1
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資料番号
遺構 法量（cm）

出土時 報告時 長 × 幅 厚さ

TA1 SK38 SK03 8.2×3.8 1.1 

TA2 SK38 SK03 4.6×4.6 0.7 

TA3 SK38 SK03 4.2×4.0 0.9 

TA4 SK40 SK05 3.6×2.4 0.8 

TA5 SK36 - 4.6×4.2 0.9 

TA6 SK38 SK03 4.0×3.0 0.8 

TA7 SK38 SK03 3.2×2.6 0.7 

TA8 SK38 SK03 4.6×4.0 0.8 

TA9 SK38 SK03 4.0×3.8 0.8 

TA10 SK38 SK03 4.6×3.8 0.8 

TA11 SK38 SK03 2.8×2.4 0.8 

TA12 SK38 SK03 2.2×2.2 0.8 

TA13 SK38 SK03 2.6×2.2 0.8 

TA14 SK38 SK03 4.4×3.0 0.8 

TA15 SK38 SK03 3.4×3.4 1.0 

TA16 SK38 SK03 3.8×3.6 0.9 

TA17 SK38 SK03 4.0×3.2 0.9 

TA18 SK38 SK03 4.4×3.0 0.9 

TAM1 SK38 SK03 5.0×4.4 0.7 

TAM2 SK38 SK03 4.4×4.4 0.7 

TAM3 SK38 SK03 5.4×3.6 0.8 

TAM4 SK38 SK03 4.6×4.4 0.8 

TAM5 SK38 SK03 4.4×4.4 0.8 

TAM6 SK38 SK03 4.0×3.4 0.9 

TAM7 SK36 - 4.8×3.0 0.8 

TAM8 SK38 SK03 5.4×2.6 1.0 

TAM9 SK38 SK03 3.4×3.0 0.9 

TAM10 SK38 SK03 2.2×2.0 0.8 

TH1 SK38 SK03 5.0×4.8 1.2 

TH2 SK38 SK03 5.6×3.2 0.7 

TH3 SK38 SK03 3.6×3.6 0.8 

TH4 SK38 SK03 4.0×2.8 1.0 

TH5 SK38 SK03 2.4×2.4 0.7 

TH6 SK38 SK03 3.8×2.8 1.1 

TH7 SK38 SK03 3.4×2.0 0.8 

TH8 SK38 SK03 2.8×2.6 0.8 

TK1 SK40 SK05 5.2×3.2 1.1

TKH1 SK38 SK03 5.0×4.4 1.0 

TKH2 SK38 SK03 5.0×4.0 0.8

TS1 SK38 SK03 4.4×4.4 0.8 

TS2 SK87 SK09 4.2×4.2 0.7 

TS3 SK38 SK03 3.2×2.2 0.7 

TS4 SK38 SK03 3.2×2.8 0.8 

TS5 SK38 SK03 3.2×2.8 0.8 

資料番号
遺構 法量 (cm)

所見 備考
出土時 報告時 長 × 幅 厚さ

MM1 SK39 SK04 5.0×4.8 0.8 目地痕跡・鋳棹痕跡有り　 連獅子＋天女 G

MM2 SK40 SK05 6.0×5.0 0.8 鋳棹痕跡有り 山椒

MM3 SK24 SK06 3.8×2.3 0.6 葉

MM4 SK24 SK06 3.2×2.5 0.9 葉

MM5 SK39 SK04 4.2×3.0 1.1 龍 A

MM6 SK39 SK04 4.3×2.7 1.0 龍 B?

MM7 SK39 SK04 7.0×3.2 1.0 目地痕跡有り 龍 A

MM8 SK39 SK04 4.2×3.0 1.0 目地痕跡有り 見返龍 A

MM9 SK39 SK04 2.7×2.4 0.9 花＋龍？

MM10 SK39 SK04 3.8×2.7 0.8 兎

MM11 SK37 SK02 3.9×2.9 0.7 天女 A× ２

MM12 SK37 SK02 4.1×3.8 0.7 鋳棹痕跡有り 天女 B× ２

MM13 SK39 SK04 3.6×2.0 0.9 見返龍 B

MM14 SK40 SK05 5.2×3.3 1.5 目地痕跡有り 不明

MM15 SK39 SK04 3.7×3.3 1.1 目地痕跡有り 龍 A

MM16 SK39 SK04 3.0×2.8 1.0 龍 B?

MM17 SK39 SK04 3.8×3.4 0.9 目地痕跡有り 龍 A

MM18 SK37 SK02 3.5×3.0 0.8 目地痕跡有り 見返龍 B

MM19 SK37 SK02 3.3×3.1 0.8 鋳棹痕跡有り 天女 E ＋ D?

MM20 SK37 SK02 4.3×3.0 0.9 鋳棹痕跡有り 不明

MM21 SK37 SK02 3.9×3.2 0.8 鋳棹痕跡有り 天女 C

MM22 SK40 SK05 3.2×2.4 0.8 不明（秋草ヵ）

MM23 SK37 SK02 3.3×3.2 0.9 鋳棹痕跡有り 天女 D

MM24 SK37 SK02 3.6×2.3 0.8 天女 A ＋ H

MM25 SK39 SK04 3.9×3.5 0.7 鋳棹痕跡有り 天女 F・獅子

MM26 SK39 SK04 2.7×2.6 0.7 鋳棹痕跡有り 馬

MM27 SK39 SK04 2.4×2.1 0.7 馬

MM28 SK39 SK04 3.1×2.4 0.8 鋳棹痕跡有り 不明

MM29 SK39 SK04 2.9×2.6 0.9 鋳棹痕跡有り 不明

MM30 SK39 SK04 2.9×2.2 1.2 不明

MM31 SK39 SK04 2.8×2.1 1.0 見返龍 A

MM32 SK39 SK04 3.5×2.2 1.1 龍 A

MM33 SK39 SK04 2.8×2.2 0.8 鋳棹痕跡有り 独鈷

MM34 SK39 SK04 2.7×2.3 0.7 天女 A

MM35 SK39 SK04 2.9×2.4 0.8 兎

MM36 SK37 SK02 2.8×2.3 0.8 天女 B

MM37 SK39 SK04 3.1×3.0 1.1 目地痕跡有り 龍 A

MM38 SK39 SK04 3.0×2.7 0.8 不明動物

MM39 SK39 SK04 2.8×2.6 0.8 見返龍 A

MM40 SK39 SK04 2.7×2.5 0.8 鋳棹痕跡有り 不明動物

MM41 SK37 SK02 2.6×2.1 0.8 天女 D

MM42 SK39 SK04 2.4×2.3 0.7 目地痕跡有り 見返龍 A

MM43 SK39 SK04 2.8×2.6 1.0 目地痕跡有り 見返龍 A

MM44 SK39 SK04 3.0×2.4 0.8 鋳棹痕跡有り 不明

MM45 SK39 SK04 3.3×2.6 1.2 龍 A

MM46 SK39 SK04 3.4×2.8 0.9 龍 A

MM47 SK39 SK04 2.8×2.6 1.3 龍 B?

MM48 SK39 SK04 2.8×2.7 0.8 目地痕跡有り 龍 A

MM49 SK39 SK04 2.4×2.3 0.8 花

MM50 SK39 SK04 3.5×2.5 0.8 目地痕跡有り 不明動物

MM51 SK39 SK04 3.1×2.5 0.9 目地痕跡・鋳棹痕跡有り　 龍 B

MM52 SK39 SK04 2.7×2.4 0.8 鋳棹痕跡有り 不明動物

MM53 SK39 SK04 3.6×2.7 0.8 鋳棹痕跡有り 獅子

MO1 SK37 SK02 5.7×4.3 1.9 鋳棹痕跡有り。雄・雌型が合
わさった状態。

MO2 SK37 SK02 3.9×3.8 1.1 鋳棹痕跡有り

MO3 SK39 SK04 5.0×4.7 0.8 目地痕跡有り

MO4 SK39 SK04 5.7×3.3 1.6

MO5 SK39 SK04 3.3×1.8 0.7

表 5　鐔鋳型一覧 表６　目貫鋳型一覧
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第Ⅲ章
奈良町遺跡出土近世刀装具鋳造鋳型の製作技法

第ⅰ節　近世刀装具の認識と課題
　近世刀装具を考古学的に検討した研究は皆無に等しい。この原因は出土事例の少なさ、製作技法や編
年を明らかにするための基礎情報に乏しいことが挙げられる。とはいえ、全く出土事例がないのではな
く、城跡等を中心に報告例があり、近年では刀装の歴史のなかに近世刀装具の考古資料を位置づけた特
別展も開催された（兵庫県立考古博物館 2018）。
　他方、近世刀装具は美術工芸品としての価値が見出されており、その方面での研究は幾分進展してい
る。その代表的著作が全８巻からなる『刀装小道具講座』であり、刀装具の種類ごとに解説や金工師と
作品の関係、用語解説等がまとめられている（若山 1972）。このうち、「後藤家編」が１巻を占めるように、
近世刀装具における後藤家作品の地位は格別のものとして評価されている。
　後藤家は京都を中心とする刀装具製作職人であり、室町時代から江戸時代後期に至るまで 17 代に渡
る宗家および分家がある。後藤家の作品は幕府御用達となり、御家彫と称される一級品となる。とくに
上三代の作品は別格とされ、後代によって作品を鑑定する極帳が作られるほどである。また、江戸時代
前期以降は、自身の作品に折紙と呼ばれる証明書を発行したり、銘を刻む作品も登場する。このように、
江戸時代のなかで価値づけされた後藤家作品は、現代においても美術工芸品として高い評価を維持して
いる。
　しかし、後藤家自身が極帳や折紙を発行したために、それを確かなものとして評価する傾向がある（島
田 1973）。これらは当然ながら参照すべきであるが、価値あるものに偽造はつきものであり、偽の折
紙やそもそも後藤家自身が高く売るために上三代のものではないものにその評価を与えたと考えられる
鑑定もある。さらに、後藤宗家であっても全ての製作工程をひとりで行ったかすら定かではない。つま
り分業体制であった可能性もあり、必ずしも同じ属性のものが同じ作者のものとは限らない。よって、
後藤家作品は年代の定点を求めうる資料ではあるが、資料から抽出した属性をもとにした分析を行い前
後関係を把握する必要性があろう。これについては、川見典久が後藤系獅子図目貫の肋骨表現の変遷か
ら前後関係を読み取ろうとする研究があり（川見 2012）、同様の分析を蓄積することで編年研究が可
能になると考える。
　このように、近世刀装具は美術工芸品としての位置づけが先行し、作者を主とする価値づけがなされ
てきた。一方、資料としての基本的な属性抽出や、その変遷等はほとんど明らかにされていない。した
がって、これらを明らかにするための基礎研究が必須であり、その上で議論する必要がある。
　
第ⅱ節　近世刀装具の製作技法に関する既往の研究
　近世刀装具には、大きく分けて鍛造品と鋳造品があり、鍛造品が主体であると考えられてきた（若松
1972）。しかし、近世刀装具資料の多くは美術館等のコレクション資料であり、良品が集まりやすい傾
向にある（黒川古文化研究所1986）。したがって、粗悪品である鋳造品は見かけ上少なくなると考えられ、
奈良町遺跡で鋳造鋳型が多数見つかり、発掘調査出土資料の多くが鋳造品であろうことからも、実際は
鋳造品のほうが数量的に多かったと推定する。
　鋳造品はそのものの注目度が低く、製作技法についてもほとんど検討されていない。しかし、刀装具
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の鋳型は全国でいくつか出土事例があり、多気北畠氏遺跡の調査報告書のなかで比較的まとまった分析
がなされている（津市教育委員会 2009）。ここで出土した鋳型は、目貫の雌型であるがこれに伴うべ
きである雄型がなく、湯口となる部分がないという特徴がある。現在、日本各地で見つかっている目貫
の鋳型（一乗谷朝倉氏遺跡や同志社大学図書館地点出土資料など）とされるものの全てがこのような形
態であることに着目した大川操は、この鋳型を製品見本を作るための文様鋳型であると考えた。つまり、
実際の鋳造に使用するのではなく、松ヤニ等を型に押しつけてヤニ型見本を作るというものである。実
際に金沢美術工芸大学に所蔵されている刀装具雛形箪笥には、文様鋳型やヤニ型が収められている。ま
た、鋳型の胎土にも着目し、文様鋳型が均質な単層の粘土で作られている一方、中世鏡・刀装具の確実
な鋳造鋳型はガス抜きを考慮しスサ混じりの粘土で外側を覆うといった複層構造をもつという違いから
も、実用鋳型との差を抽出した。このような実際の鋳造に用いる鋳型である実用鋳型と、それとは異な
る製品見本を作るための文様鋳型があることを示した点は重要である。
　他方、鍛造品がどのように製作されたのかは明らかにされていない。一般的には型紙をもとに金属板
に図像を転写して打ち出しながら成形すると考えられている（若松 1972）。ただし、これを証明した
研究はなく推測にすぎない。　
　これとは異なる製作技法を久保智康が一乗谷朝倉氏遺跡出土資料をもとに検討している（久保
2009）。一乗谷朝倉氏遺跡では先に紹介した文様鋳型のほかに鍛造品と考えられる獅子図目貫が出土し
ている。この状況から、文様鋳型を鍛造工程で使用したものと考え、具体的には金属板を型に打ち込ん
で成形したのち、型から外して細部を鏨彫するという工程である。伝世資料のなかにも裏面に叩き込ん
だ痕跡のあるものが確認されており、この可能性を追認する。しかし以後、この可能性を追求した研究
は示されておらず、この技法が成立しうるかの検証は行われてない。とくに、叩き込んだ際には、少な
からず型が壊れる可能性がありその確認作業は必須である。
　以上、鋳造・鍛造製品の製作技法に関していくつかの先行研究を挙げたが、いずれも単発的なもので
あり持続的な研究が行われていない。ただし、重要な見解が提示されていることも確認でき、今後追求
すべき課題は多い。本研究では、鋳造鋳型という基礎資料をもとに鋳造技術の復元を試みるが、この成
果は鍛造品との比較検討にも今後有効になると予測できる。
　
第ⅲ節　奈良町遺跡出土資料にみる鋳型の製作技法
　近世刀装具は、鋳造・鍛造品を問わず、製作技法に関する体系的な研究がなく、これを明らかにする
ことがまず求められる。本研究では、とくに鋳造品に関する製作技法を明らかにするために、奈良町遺

図 20　文様鋳型（左：一乗谷朝倉氏遺跡出土）と実用鋳型（右：奈良町遺跡出土）
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跡出土資料を分析する。鋳造技術を明らかにするためには、鋳型がどのように作られて、使用されたの
かが重要であり、その第一段階である鋳型の製作技法に関する観察所見を提示する。
ⅲ−１）鋳型の製作技法について
　一般的な鋳型の製作技法には大きく３種類あり、惣型・込型・蝋型技法がある。
惣型技法　粘土に直接図像を彫って鋳型とする。
込型技法　粘土に原型を押しつけて全体を覆い、原型を取り出して再度合わせて鋳型とする。
蝋型技法　蝋原型を粘土で覆い、熱して脱漏し鋳型とする。
　刀装具鋳型は込型・蝋型技法を用いた可能性が高い。込型技法は大量生産が可能である一方、薄い原
型であると合わせる際に潰れる恐れがある。蝋型技法は細部の細かな製品に有効であるが、蝋原型を製
作する手間がかかる。
ⅲ−２）笵型の配置方法

【込型技法】

【蝋型技法】

①粘土に金属原型
を押し付ける

②もう半分を粘土で
覆い包み込む

③原型を取り出す
（雄・雌型の完成）

④湯口を設け雄・雌型を合わ
せて金属を流し込む

⑤完成

①粘土に金属原型
を押し付ける

②できた雌型に蝋を
流し込む

③蝋原型ができるが、内面
を削って目貫状にする

④粘土に蝋原型
を押し付ける

⑤湯口を設け粘土で
覆い火にかけて脱蝋
する

⑥金属を流し込む ⑦完成

①粘土に金属原型
を押し付ける

②もう半分を粘土で
覆い包み込む

③原型を取り出す
（雄・雌型の完成）

④湯口を設け雄・雌型を合わ
せて蝋を流し込む

⑤蝋原型の完成

図 21　一般的な鋳型の製作技法

図 22　同笵（上）と異笵（下）

　奈良町遺跡出土資料は、肉眼観察では図像や細部の特徴が不明瞭
であったが、三次元計測を行うことで多くの視覚的情報を得ること
ができた。とくに、どのような笵型があるのかが明らかになったこ
とで、その配置方法について検討できるようになった。
　まず、ひとつの鋳型に複数の笵型が施されていることは肉眼観察
でも明らかであったが、大きく２種類の傾向を読み取れた。ひとつ
は鋳型内の笵型が全て同じであるもので、他方は異なる笵型である
ものである。異なる笵型であれば、それぞれの原型があれば可能で
あるが、同じ原型をひとつの鋳型に施す場合は、同型品が複数必要
となる。ただし、鋳型は鋳造後に砕かれているため、鋳型に複数の
笵型が確認できる状態のものは少ない。現状、同一笵型を複数鋳型
内に施すものは少ない。
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　また、笵型の配列については規則性がなく、同様の意匠でまとまるものもあるが、全く異なる意匠の
ものが配置される場合もある。このことは、目貫が２個１対で用いられるのに対して、そういった意識
が製作時には働いていないことを示す。
ⅲ−３）鋳棹の設置方法
　次に、湯口と笵型を繋ぐ鋳棹の痕跡に注目する。奈良町遺跡出土資料は、全てに鋳棹部分が観察でき、
文様鋳型とは異なる実用鋳型であることを示す確実な証拠である。この鋳棹部分の形状を観察すると規
則性がなく、笵型とは別に施された可能性が高い。ただし、鋳棹部分の形状はハの字状になるものが多
く、概ね同じ手法で施されたと考えられる。このことから、工具を用いて笵型を施す際に付け加えられ
たと考える。また、鋳棹の取り付け部分は、例えば天女であれば足の部分に取り付くように施されてお
り、この点については規則性が読み取れる。
ⅲ−４）鋳型側面にみられる目地痕跡
　筆者は当初、鋳型の製作技法を検討するなかで、鋳型に目地の痕跡が見当たらないことや、目貫は完
成品の厚みが１mm 前後であることなどから、蝋型技法で製作した可能性を考えていた（村瀨 2018）。
つまり、ひとつの笵型のみの鋳型を合わせることは可能であっても、２〜３つの笵型が施された隙間の
ほとんどない雄・雌型を潰さずに合わせることは困難と考えたのである。
　しかし、この見解を口頭発表する機会を得た際に、龍図に目立ってみられる側面の窪みが目地にあた
る可能性をご指摘いただいた（２）。後日、この窪みに着目して資料を見直したところ、龍図の多くに同
様の窪みが観察できた。よく観察すると、窪みには抉った際の工具痕跡が確認でき、少ないながら雄型
にも窪みを確認した（MO3）。また、龍図だけでなく並列配置した鋳型（MM １）でも同様の窪みを観
察できた。
　この痕跡について、例えば鋳型乾燥時の紐で縛った痕跡等とも考えられるが、側面にしか痕跡は観察
できず可能性は低い。このことからも、この窪みが込型技法における鋳型を合わせる際の目地である可
能性が高い。

MM７ MM17

MM１MO3

MM17

MM1

図 23　目地の痕跡
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ⅲ−５）鋳型製作上の工夫
　奈良町遺跡出土資料のなかには、鋳型をふたつ重ね合わせて目張りしたものが確認でき、ほぼ全ての
鋳型が同様の手法により製作されたと考えられる。つまり、ひとつの鋳型を目張りして固定し、さらに
それをふたつ重ね合わせて目張りしひとつの湯口を設ける。この工夫は、坩堝で溶かせる金属量に関わ
るものと考えられる。
　なお、湯口の残存する個体は図 14・24 の３個体のみであるが、茎子孔に対する湯口の方向は一定で
はなく、銅鏡のような湯口の方向を意識した規則性は認められない。
ⅲ−６）奈良町遺跡出土刀装具鋳造鋳型の製作工程
　以上の観察所見をもとに、奈良町遺跡出土刀装具鋳造鋳型の製作工程を復元する。
　まず、鋳型の製作技法については込型・蝋型技法があるが、目地を確認したことから込型技法で製作
されたと考える。この技法に沿って資料の特徴を加味しながら述べる。
①スサ混じりの基礎粘土上に精良な粘土を被せて、そこに金属原型を押しつける。
②同様の粘土を作り、覆うように原型に粘土を押しつけてパックする。
③工具を使って側面を刳り込み目地をつけてから、合わせた粘土を開いて原型を取り出す。
④出来た雄・雌型を目地をみながら合わせるが、この時工具を挟み込んでおき、合わせた際に軽く刳り
抜くようにして鋳棹部分を作っておく。
⑤鋳棹部分を除く外側をスサ混じりの粘土で目張りして、合わせた状態で乾燥させる。開いた状態で乾
燥させると、歪み等により合わせづらくなるためこのタイミングで乾燥させた可能性が高い。
⑥乾燥後、ふたつの鋳型を重ね合わせてスサ混じりの粘土で目張りする。この時、鋳棹の方向を合わせ
ておき、その部分に大きめの湯口を設けておく。
⑦乾燥後、金属を流し込み製品を作る。

図 24　鋳型の重ね合わせ・湯口の設定が観察できる資料

【奈良町遺跡出土刀装具鋳型の製作技法】

目地

工程① 工程② 工程③ 工程④・⑤ 工程⑥ 工程⑦

鋳棹部分 湯口

図 25　鋳型製作技法の復元模式図
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第ⅳ節　奈良町遺跡における近世刀装具生産
　分析の結果、込型技法を用いた工程が復元でき、量産を目的とした生産が行われていたことが明らか
となった。本節ではこれをもとに、奈良町遺跡における近世刀装具生産について予察する。
　まず、近世奈良町では町ごとの職人等を記した史料が残る。貞享四（1687）年の『奈良曝』には、
柳町に刀屋の吉兵衛、鞘塗師の勘介、とぎ屋の木屋五兵衛がおり、刀・装具関連の職人が集まっていた
ことが読み取れる。20 年後の宝永年間に記された「町代高木又兵衛諸事控」にも、柳町に京刀屋吉兵
衛とある。しかし、享保年間に記された「町代和田藤右衛門諸事控」には記載がなくなる。このことか
ら、少なくとも今回対象とした出土資料との関連は刀屋の吉兵衛に関連する可能性が高い。
　ただし、HJ 第 688 次調査で出土した鋳造関連遺物と共伴する土器の年代は 17 世紀前半であり、『奈
良曝』にはじめてみえる刀屋の吉兵衛とは直接結びつかない。可能性としては、吉兵衛の先代にあたる
職人の工房が HJ 第 688 次調査成果に関連すると考えられる。
　両者が結びつく要因のひとつに、刀屋の吉兵衛が「町代高木又兵衛諸事控」には京刀屋と記載されて
いる点である。HJ 第 688 次出土目貫鋳型は、意匠が後藤家（京都）のものと類似し、その模倣品と言える。
このことからも、史料にみる京刀屋吉兵衛は今回の出土資料と関連するものとみて良いと考える。
　これをふまえて、奈良町遺跡で鋳造品の刀装具が作られる意義を考える。端的に言えば、鋳造品は量
産品であり、しかも当時の一級品である後藤家の意匠を採用している点から、模倣品生産そのものの実
態であると言える。しかし、この時代に鋳造模倣品が量産されたという事実は、近世刀装具生産を考え
る上で非常に有意義なことでもある。それは、量産品に対する後藤家ブランドの維持と関連する。
　京都後藤家が折紙発行を開始したのは６代栄乗の頃とされ、古極帳による記録では慶長 12（1607）
年のものが最古とされる（酒井 2016）。折紙は自身の作品であることを証明するものであり、逆説的
には模倣品があるからこそ証明する必要が生じたと考えられる。HJ 第 688 次調査で出土した資料は概
ねこの時期と合致しており、量産品が生産されたことと折紙の発行が密接に関わる可能性を示唆する。
　ただし、ここで検討すべき課題として、意匠を似せることはできても、鍛造品と鋳造品とでは細部の
彫金や質感が圧倒的に異なる。そのため、意匠だけが同様の鋳造品が出回ったからといって、後藤家の
確かな作品の価値が危ぶまれる直接的な原因にはならないと考えられる。
　そこで要点となるのが、HJ 第 688 次調査で出土した鋳型に共伴する坩堝類である。これらは分析の
結果、真鍮製造・注ぎ込みをしたことがわかっており、目貫などは真鍮製品を生産したと考えられる。
真鍮の製造は難しく、これまでは江戸時代中期以降に本格化したと考えられてきたが、この調査によっ
て江戸時代前期に遡ることが確実となった。真鍮は亜鉛の配合率により金にかなり近い発色を示すこと
があり、肉眼観察では識別が困難であるものも多い。銅および亜鉛の価格自体は金よりはるかに安価で
あったことが想定できるが、真鍮の価値がいかほどであったかは今後の課題である。それを考慮せずと
も、奈良町遺跡で真鍮の製造に成功したことは、費用対効果の高い真鍮製品を生産できることに繋がっ
たのである。将軍が身につけるような高価な後藤家作品には手が届かないが、安価でそれなりに見た目
も整う真鍮製品が流行したであろうことは、現代に置き換えても容易に想像がつく事象である。つまり、
このような買い手側の需要に適した量産品が大量に出回ったことが、確固たる後藤家作品の価値を再提
起する折紙発行に繋がったものと考えられよう。
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第Ⅳ章
埋蔵文化財行政における実現可能な三次元計測の導入

　埋蔵文化財に対する三次元計測の導入は、2000 年代以降、徐々に普及しつつある。例えば、横穴式
石室の計測（大阪市立大学日本史研究室 2010）、銅鏡の計測（奈良県立橿原考古学研究所 2005）、大
型古墳の計測（奈良県立橿原考古学研究所 2011）、埴輪の計測（城倉 2017）などが挙げられる。
　しかし、上記の三次元計測方法の多くはレーザを利用したものであり、その機材は高価であるため、
埋蔵文化財行政への普及は遅れてきた。この状況を大きく変えたのが、SfM（Structure from Motion）
を用いた三次元計測技術である。この技術の普及により計測単価が抑えられたことで、遺構図や遺物実
測図の下図（オルソ画像）を専門業者に委託し作成する行政機関は、とくに 2010 年代以降に急増して
いる。SfM による三次元計測は、個人レベルでも導入可能な方法であるため、その活用方法について
も議論が深められている（文化財方法論研究会 2016）。
　そこで、本章では埋蔵文化財行政に対して実現可能な三次元計測の導入について、費用対効果を意識
した観点および、本研究をふまえた視点で活用方法を提示する。結果として、業者に委託するメリット
もあるが、行政レベルでの導入も実現可能であり、場合に応じて利用することが有効であるとわかった。

第ⅰ節　考古学分野における三次元計測の種類
　考古学分野で採用されている三次元計測の方法は、レーザスキャナおよび SfM の２種類がある。
　レーザスキャナは、レーザビームパルスにより対象物を測距して点群データを得るのに対し、SfM
は複数枚の画像から対象物の三次元形状とカメラの位置を同時認識して点群データを得る。したがって、
直接測距により点群を得るレーザスキャナは SfM に比べて正確で高精度である。
　しかし、その価格には大きく差があり、考古学業界で用いられているレーザスキャナのうち、例え
ば奈良県立橿原考古学研究所で使用されている ATOS Compact Scan 5M は約 500 万円と高価である。
一方、SfM はその解析ソフトとして一般的に用いられる Metashape は Pro 版で約 50 万円、Standard
版で約３万円である。上位機種のデジタルカメラ、PC を購入しても Standard 版であれば合わせて 40
万円程度で計測が可能である。本研究でも概ねこの予算で計測機材を揃え、十分な成果を得ることがで
きており、レーザスキャナで計測された鋳型と２次元画像上であれば比較しても特段劣らないことも確
認できた。

第ⅱ節　実現可能な三次元計測方法 -Metashape ＋ CloudCompare を利用した計測 -
　ここでは、上述した三次元計測のなかでも、埋蔵文化財行政として実現可能な方法である SfM を用
いた計測方法について具体的に紹介する。
　まず、SfM がどのような原理で三次元化を果たせるのかを概説する。SfM とは、移動するカメラか
ら得られる画像をもとに形状を復元する技術の略称である。被写体を撮影した１枚の画像自体は２次元
であるが、本来の被写体自体は当然ながら３次元である。この被写体を複数角度から撮影することで、
被写体の立体的構造を認識し復元することができる。これは、複数枚の画像から被写体を点群として認
識して処理し、点群の重複や位置関係を算出することで可能となる。したがって、レーザスキャナが被
写体に対して直接レーザを照射し、距離を含めた位置関係を認識しながら点群を構成するのとは異なる
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ため、精度が幾分劣る。
　原理についての詳細は専門書等を参照して頂きたいが、簡潔に言えば、カメラで撮影した複数枚の写
真画像から三次元モデルを作成することが可能なソフトおよび技術がある、ということである。当然、
原理を理解した上で計測しなければ精度を向上させることはできないが、原理を理解せずとも三次元計
測が可能なほど利便性の高い方法があるということでもある。
　このように、SfM は非常に利便性の高い三次元計測方法として注目され、考古学分野でも多く活用
されている。以下では、SfM を用いた三次元計測を誰もが活用できるように、その方法を記述する。

【必要機材】
　SfM を用いた計測に必要な機材は、デジタルカメラ、パソコン、処理ソフトのみである。必要に応
じてライト、三脚などの補助機材が必要であるが、ここでは研究代表者のものに準じて述べる。
デジタルカメラ：OLYMPUS OM-D E-M1 mark Ⅱ
→高性能のデジタル一眼レフカメラで撮影する方が、より精度の高い計測結果を得られるが、その分処
理が重くなり、高性能パソコンが必要となる。処理は JPEG ではなく TIFF のほうが良好な結果が得ら
れるため、RAW 撮影できる機材が望ましい。OLYMPUS OM-D E-M1 mark Ⅱは防塵・防滴であると
ともに撮影精度が高く、高度な SfM 活用にも適した機能が搭載されているため、現段階の SfM 計測に
適したカメラである。
パソコン：apple iMac 21 インチ corei5 16GB
→パソコンについては、CPU やメモリが高性能であるほど解析速度が速い。処理ソフトの推奨メモリ
は８GB 以上であるが、最低でも 16GB 以上でなければかなりの解析時間を要することになる。OS は
Windows・Mac のいずれでも可能であり、扱いやすさを重視するのが良い。
処理ソフト：Metashape Standard および CloudCompare
→ agisoft Metashape は 2018 年まで Photoscan としてリリースされていたソフトであり、名称が変
更されただけで同様のものである（３）。Professional 版と Standard 版があり、Professional 版だとス
ケール調整など全ての作業が可能であるが、現状高価であることから手軽に導入できない。Standard
版ではテクスチャー構築等までが可能で、様々な形式で三次元計測データが保存できる。Standard 版
で困難なスケール調整等はフリーソフトの CloudCompare を使用することで補うことができる。今回
は CloudCompare を利用してより実現可能な計測方法を採用した。
図面編集ソフト：Adobe Illustrator 等
→上記処理ソフトで得た三次元計測データは、現状印刷物等で二次元化して掲載する。この際は、遺物
実測図等と同様に、Illustrator 等を利用した図面編集を行う。
ライト：Yongnuo YN-300 Ⅲ
→基本的にどんなものでも問題ないが、最低でも２つ以上の光源があることが望ましい。陰影が激しい
場合、処理時の不具合に繋がる恐れがある。本研究では、安価かつ軽量であり、十分な光量をもつ製品
を選択した。
三脚・垂直撮影台：カメラを固定する際は三脚を利用する。俯瞰撮影の場合は垂直撮影台を利用する。
回転台：本研究で対象とする資料は小型であったため、ケーキ作り用の安価な回転台を使用した。大型
品になるとそれなりに頑丈なものを揃える必要がある。
その他：グレーカード、レフ板など撮影に必要な小物があるが、筆者自身も試行錯誤段階であり、方法
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を検討しながらより良い結果を得られる工夫を随時行う
と良い。

【計測方法】
　基本的な方法は、対象資料を複数角度から撮影
→ RAW データを TIFF データに変換→ Metashape での
処理→ CloudCompare での調整→　Adobe Illustrator
等での図面作成である。
１）対象資料を撮影する
　対象資料を回転台等に据え置くが、この時直角スケー
ルをなるべく近い位置に据えておく。このスケールを用
いて後に調整を行う。ライティングはなるべく陰影が出
ないようにセットするのが良い。撮影は垂直方向から４
〜５枚程度、斜め方向から 20 枚程度（対象資料により
適宜変更）連続的に行う。RAW モードで撮影し、後に
TIFF 変換するためにグレーカードを入れた写真も撮影
する。いずれの写真も概ね 60% 重複させておくと解析
結果が良好となる。逆に不用意に撮影枚数が多くなると
点群処理に不具合が発生し、上手くモデル化できない場
合がある。これについては、対象資料により異なるため
テストを行うと良い。
２）撮影したRAWデータを TIFF に変換する
　RAW データはフィルム写真でいうネガの状態で、そ
のままでは一般的なソフト（Adobe や Microsoft）で
使用できない。そのため、TIFF や JPEG といった汎用
性の高いデータ形式に変換する必要がある。最初から
JPEG 撮影することも可能であるが、SfM ではより低圧
縮な TIFF のほうが解析結果が良好であるため、この工
程を経る必要がある。
　変換には、Adobe Bridge の cameraRAW のほか、各
メーカーのフリーソフトを使用して行うことができる。
RAW データはメーカーによって拡張子が異なるため、
フリーソフトを使用する場合はメーカーのものを用いな
ければならない。とくに新型カメラは拡張子が対応しな
い場合があり、アップデートを随時行う必要がある。
　具体的な変換方法は、グレーカード入り写真と一連の
写真を選択し、一連の写真を選択した状態でホワイトバ
ランスツール（スポイト）をグレーカードに合わせて
RGB 値を平均化する。これにより、色ムラを排除する

図 27　RAW 現像して TIFF データを得る

図 29　アライメントを実行する

図 28　画像を追加する

図 26　対象資料を撮影する風景
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ことができ、後は適宜レベル調整して TIFF 画像として
保存する。
３）Metashape に画像を追加する
　　Agisoft Metashape は海外製品であるが、日本語に
設定することが可能であり使用方法もオーク社等の代理
店では概説書がある。詳細はそちらに譲るが、ここでは
使用するための大まかな流れを記述する。
　まず Metashape を開き、ワークフローを選択し写真
を追加する。追加するのは三次元化したい対象資料を撮
影した全ての写真である。追加すると、画面下方に追加
した写真が表示される。
４）写真のアライメントを行う
　ワークフローを選択し写真のアライメントを行う。こ
れは、撮影したカメラの位置関係を三次元的に認識する
作業である。処理精度は高いほど結果が良好だが時間を
要する。
５）高密度クラウドを構築する
　ワークフローを選択し高密度クラウドを構築する。ア
ライメントした画像から点群を構築する作業であり、ア
ライメント時と同様に処理精度は高いほど良好である。
この作業が最も時間を要する。
６）メッシュを構築する
　ワークフローを選択しメッシュを構築する。高密度ク
ラウド（点群）を構築した状態は、点の集合であるが、
この作業により点と点が結ばれ頂点・辺・面からなる多
面体オブジェクトとなる。
７）テクスチャーを構築する
　ワークフローを選択しテクスチャーを構築する。この
作業は、撮影した画像をポリゴン（多角形）と同じ位置・
大きさに変形して重ね合わせることで、単色では表現で
きないよりリアリティのあるモデルを構築するためのも
のである。
８）三次元モデルを保存する
　ここまでの作業で、大きさは任意の状態であるが三次
元モデルが完成する。standard 版ではスケール調整が
できないため、ここでモデルの保存を行う。ファイル→
エクスポートを選択しモデルをエクスポートする。この
時、ファイル形式は選択することができるが、obj. を一

図 30　アライメント実行後の粗い点群

図 31　ポイントクラウド構築後の密な点群

図 32　メッシュ構築後のモデル

図 33　テクスチャー構築後のモデル

図 34　三次元データを保存する
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般には使用する。ポイントをエクスポートすることもで
きるが、これは高密度点群を保存する場合に使用する。
ここでは一連の流れを記してきたが、保存は各作業ごと
に行うのが良い。とくに撮影枚数の多い場合は途中で処
理がダウンすることがあるので注意が必要である。また、
保存する際のデータ名はローマ字・数字等にする。これ
は日本語にすると次に使用する CloudCompare でバグ
が生じる恐れがあるためである。極力ハードディスク名
やファイル名すべてこれに準じておいた方が良い。
９）CloudCompare でモデルを表示する
　CloudCompare は日本語表示ができず、チュートリ
アル等も少ないため使いながら覚えるか、文化財方法論
研究会等で研修を受けるのが良い。近年、有志による日
本語化が進められており、近く日本語利用できるソフト
になると見込まれる。
　まず、Metashape で生成したモデルを表示するため
には、ツールバーの File → Open を選択しデータを開く。
この時、下方のファイル形式を開き、データのファイル
形式と合わせておかないと開かないので注意する。
10）法線曲線を計算する
　表示されたモデルをクリックすると枠が表示され
選択された状態になる。その状態でツールバーから
Edit → Normals（法線）→ Compute（計算する）を選
択する。すると per-triangle または per-vertex かの選
択を迫られるので、per-triangle を選択する。これによ
り法線曲線が計算されるが、この作業をしておかないと、
CloudCompare 上でテクスチャーを外した際にソリッ
ドモデルが表示されない。
11）座標値を設定してスケール調整する
　スケール調整するにはモデルを選択した状態にして、
Tools → Registration → Align（point pairs picking）
を選択する。すると新たな画面が出てきて、画面をク
リックするとその点の任意座標が表示される。よって、
まず直角スケールの０の点をクリックする。align の方
に適当な座標値が表示されるので、次に下の reference
の方の鉛筆マークをクリックし、任意の座標値を入力
する。３点を決めれば align をクリックする。これによ
り、任意に設定した座標値が反映されるので、対象資料

図 35　法線曲線を計算する

図 36　スケールを調整する

図 37　不要な部分を削除する



第Ⅳ章　埋蔵文化財行政における実現可能な三次元計測の導入

30

のスケールも自動的に正確なものに調整される。最後に
チェックボタンをクリックして完了する。
　この作業を終えると、資料の位置関係が確定するため、
左側にある視点方向を選択できるツールを選択すると、
決まった角度から対象資料をみることができる。資料を
展開図的に掲載する場合には便利である。
12）不要な部分を削除する
　スケール調整ができれば、写し込んだスケールや背景
等の不要な部分を削除できる。ツールバーのハサミのコ
マンドをクリックするとさらにツールバーが出てくるの
で、不要な部分をコマンドで囲み切り抜きコマンドを選
択する。全てが完了すればゴミ箱コマンドを選択する。
13）断面図を作成する
　 断 面 図 を 作 成 す る 場 合 は、 ツ ー ル バ ー の
Tools → Segmentation → Cross Section を選択する。
すると、上下左右に矢印マークが表示される。例えば横
方向の断面をとりたい場合、まず上下どちらかの矢印を
断面位置までクリックしながら移動させる。そしてもう
一方の矢印を同様に移動させる。この時、上下の矢印が
完全にひっついていると断面が表示できないので、わず
かに間隔をあけておく。そして、Slices の左側（Export 
selection as a new cloud）を選択すると断面の切り取
りが完了する。すぐ下の視点方向を変更するツールで横
から見てみると断面が線状に表示される。
　なお、断面をとると左側の DB tree に section のレイ
ヤーが表示される。資料のレイヤーチェックを外すと断
面のみが表示できる。今後の作業のため、断面は資料と
異なる色にしておくと良い。色の変更は、ツールバーの
Edit → Colors → Set unique を選択すると変更できる。
14）モデルを画像として保存する
　画像として保存する際は、Display → Render to File を選択するとファイル名や保存先フォルダが指
定できる。この時、画像サイズも指定できるので適切な設定を行う。保存する際の注意点としては、ス
ケールバーを入れずに保存することができるが、後の編集に必要であるためスケールバー無しを選択す
るチェックボックスにチェックを入れない。また、いくつかモデルを保存する場合はスケールバーが同
じ大きさになるよう拡大・縮小してから保存するのが良い。
　なお、断面図は section レイヤーのみを表示して保存する。切り位置は資料のモデルレイヤーと合わ
せて表示すると、断面の色が異なっていれば切り位置がわかるので、その状態で保存する。注意点とし
て、オルソ画像等を保存する時は、section レイヤーのチェックを外しておかないと切り位置が入った

図 38　断面図を作成する
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状態となるので気をつける必要がある。
15）ソリッドモデルを加工・保存する
　また、ソリッドモデルを保存したい場合には、左側
ツールバーの Properties 中にある Materials/Texture
のチェックを外すと単色のソリッドモデルが表示され
る。色の変更は、ツールバーの Edit → Colors → Set 
unique を選択すると変更できる。保存方法は上述の通
りである。
16）イラストレーター等で図面化する
　以上の方法で画像を保存したら、Adobe Illustratior
等を利用して図面化する。展開図等であれば必要な画像
を配置する。この時、図面化する時の縮尺に合わせてス
ケールバーを参照しながら画像を拡大・縮小する。全て
のレイアウトが終わればスケールバーは不要なので、マ
スク等をかけて消しておく。また、Cloud Compare で

図 39　ソリッドモデルを加工する

保存した断面画像は、点が集合したようになっているため、なぞって製図する。以上の作業を経て、一
般的な考古学関連報告書等でみる仕様として仕上げられる。

第ⅲ節　三次元計測の有効性と問題点
　以上で紹介した三次元計測方法は、機材費用も比較的安価であり、計測方法も一定水準までは容易に
習得できる点で、実現可能な方法であると考える。おそらく、１〜２回程度の計測委託料で機材は揃え
ることができ、一定水準の計測については半年程度あれば十分習得できる。
　このような説明をした際によく頂いたご意見として、「確かにその通りかもしれないが、計測する手
間等の人件費を考えると厳しい」というものである。確かにその通りではあるが、それを言えばこれま
での遺物実測作業も委託すればいい、ということになる。
　つまり、三次元計測はただ機械的に計測するものであると思われがちであるが、十分に観察しておか
ないとうまく写真撮影ができず、画像処理をする段階でも必要な情報を表現できない場合がある。さら
に言えば、これまで計測（実測）を委託するような資料（主に大型遺物や本研究で用いた鋳型などの複
雑な遺物）は、観察が不十分なことに起因してか研究進度が他に比べて遅れているようにも感じる（例：
須恵器の大甕、形象埴輪など）。
　よって、三次元計測の醍醐味は、これまで自らの実測作業が困難であった資料を、自分の手で計測・
図化することが可能になったことであると考える。この視点にたてば、これまで資料化しづらかった遺
物に対する研究が進むことが期待できる点で非常に有効であり、従来手測りで実測してきた資料につい
ても、三次元計測を応用することで新たな視点からの研究が進むことも期待できる。
　また、美術館等の考古資料では、手測り等による実測が作品を傷つける可能性があることから困難な
場合がある。このような時も、SfM による計測であれば最小限の接触で図化が可能である。
　このような有効性がある反面、問題点もある。まず、SfM による計測は写真画像をもとにするため、
レーザ等に比べて精度が劣る。現状、三次元計測を行っても、それを活かす主な場面は報告書等の二次
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元媒体でありその差はあまり無いように感じるが、三次元でみた場合には確かな差が認められる。しか
し、きちんと計測が可能な資料であれば、手測りするより誤差は当然少なく、あくまで高精度レーザと
比較した場合である。目的に応じて使用することで、効果的な計測ができると言えよう。
　また、写真を撮影しづらい資料についても計測が困難である。例えば、細頸壷の内面は撮影困難でモ
デル化できない。ほかに、蓋形埴輪の笠部のように撮影は可能であっても重複しながらの複数カットが
撮りづらい資料も点群の粗密ができてしまいモデルに穴があく場合が多い。
　ほかにも、撮影の際に据え置く面は一度にモデル化できないため、別途撮影してモデル化し、合成す
る必要がある。この作業も CloudCompare 等で可能であるが、誤差が生じる場合が多く試行錯誤が必
要となる。

第ⅳ節　まとめ
　以上、埋蔵文化財行政における実現可能な三次元計測の方法および有効性・問題点を提示した。三次
元計測はあくまで表現方法のひとつであり、従来の手測りに置き換わるものとしてとらえるべきではな
い。このことは、すでに考古学分野における先駆的な三次元計測および方法論や有効性を提示されてい
る金田明大により明示されてきた（金田 2019）が、それを追認する結果となった。この計測方法を臨
機応変に取り入れることで、より精度の高い資料化、またそもそもこれまで資料化が困難であった遺物
の図化が可能となり、さらにこれをもとにした研究が進むことが期待される。
　また、三次元モデルはこれまでの平面的な写真や図に比べて資料の立体的イメージがしやすく、一般
市民等へ説明する際には視覚的効果が高い。講演や講座等での使用に限らず、博物館や展示施設等でも
モニターでの映像表示、iPad 等で自由な操作が可能であれば、来館者への知的好奇心をより刺激する
ことにも繋がり得る。これらの備品導入が難しい場合でも、三次元モデルをオープンスペースで公開す
れば、個人のスマートフォン等から閲覧することができる。
　このように、三次元計測の導入は、これまでなし得なかった領域へ踏み込むことが可能になる点で有
益性が高く、研究水準の向上・行政サービスの面でみても活用していくべき技術である。
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第Ⅴ章
総 括

　本研究は、近世鋳造技術の解明に繋がる近世刀装具鋳型の製作技法を明らかにすることを目的とした。
これを達成するためには、まず鋳型がどのようなものであるのかを把握し、尚且つ第三者に図示する必
要があった。これを成し得る方法として SfM による三次元計測が有効であると考え実験した。その結果、
肉眼観察では確認できない細部の特徴を抽出することに成功し、基礎資料として提示することもできた。
　次に SfM による計測で得られた基礎データをもとに、奈良町遺跡出土刀装具鋳型の製作技法を検討
した。その結果、込型技法による鋳造を行ったとみられる痕跡を複数確認し、それによる鋳造工程の復
元を提示した。ただし、これはあくまで本研究で対象とした奈良町遺跡（HJ 第 688 次）出土資料から
得た結果であり、近世における刀装具の鋳造方法が全て込型技法であるとは言えない。この点は今後分
析を継続し明らかにすべき課題である。
　また、本研究では SfM を用いた計測により多くの情報を得ることができたが、この方法が埋蔵文化
財行政において、どういった場合に有効であるのかを検討した。その結果、全ての資料に対して有効で
あるものではないことを前提としつつ、従来自分の手で図化することが困難であった大型資料などを自
らの手で表現することができる方法であることを明らかにした。大型資料は委託による図化がこれまで
行われてきたことや、そもそも図化を断念する場合も多くあったため、研究が進展しなかった資料が多
数ある。こういった資料に対して、研究者自身の手で第三者に図示する方法を得たことは、今後の研究
に大きく影響を与えるものと考える。以上をふまえて、埋蔵文化財行政における実現可能な三次元計測
の導入についてを提示した。
　今回は小さな資料を研究対象としたが、SfM は遺構に対しても行うことができる。不慣れな場合、遺
構の計測は失敗する可能性も高く、未だ業者委託するほうが効率的である場合も多い（４）。ただし、例
えば井戸や古墳の葺石などを段階的に記録する場合、最終状態は委託計測するにしても、自らある程度
SfM 計測を行うことができれば途中段階の記録を迅速に行うことができ、これまで止むを得ず記録で
きなかった遺構の状態を短時間で記録することが可能となる。
　以上のように、本研究では第一目標であった近世刀装具鋳造鋳型の製作技法を明らかにすることがで
き、近世鋳造技術の一端を解明することができた。さらに、これをなすにあたって身につけた SfM に
よる計測技術が埋蔵文化財行政において費用対効果が高く、より仕事・研究を進展させる方法であるこ
とを明らかにした。
　最後に今後の課題をまとめると、まず本研究は１年間で成果を出す必要があったため、目的に応じた
情報の抽出、つまり鋳型の計測であれば、今回はあくまで表面的情報の抽出を主としたものである。た
だし、込型技法であれば原型を押し付ける際の加減は断面で観察できるため、本研究で示した情報だけ
ではそれを検証できない。これは鋳型の全体的な情報を含めて今後三次元で提示する方法を検討する必
要がある。次に、本研究では製品からみた鋳造痕跡の分析には至らなかった。この点は次年度以降に、
製品からみた製作技法を検討する際の課題としたい。
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註

（１）奈良市と奈良大学の連携協定に基づき実施する共同研究であり、2018年度以降は西山要一先生が研究代表者であるJSPS科研費基盤研究（A）「古

代〜中世の「鍮石」と「真鍮」の研究 - 金に等しい価値があったころ -」のなかで、奈良町遺跡出土資料の科学分析を継続的に実施する計画である。

（２）林弘幸氏（大手前大学大学院生）のご教示を得た。

（３）本研究期間の後半期にアップデートがあったため、今回実施した計測作業は Photoscan として行った。

（４）筆者が担当した富雄丸山古墳の発掘調査（奈良市教育委員会 2019）では、多くの葺石等が検出され、自ら SfM 計測することも視野に入れて

いた。しかし、作業員および学生への指示、発掘体験等の複数業務がある場合、自ら落ち着いて計測する時間を捻出できなかった。また、遺構の

場合、対象が広範囲であるため解析も複雑となりそれ相応の高性能 PC が必要となる。以上をふまえると、業者委託が有効な手段である場合もある。
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図 16 〜 19・21 〜 23・25 〜 39：筆者作成

図 20：（水野 2010）
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